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For over 10 years, Outlook had been the vehicle through which I 
managed my life. It was my calendar, the hub for all of my tasks, a 
very complete contacts list, and warehouse for reference 
information. Because these four modules, together with email, are 
part of one integrated program, the various components work well 
together.

As I work with other people, I find Outlook to be available to a 
large number of them. Most use Outlook to send and receive 
email. Few,  however, use the other components. 

“Tasks” is the most universally underutilized part of Outlook. 
Much of the reason is lack of clear methodology for setting up 
and operating the Task List. This guide will focus on helping you 
with a setup which is simple and easy to maintain. You will learn a 
methodology which can be transferred to other software.

Readers will be working from different versions of Outlook. This 
publication will address the major concepts which apply to all 
Outlook users.
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Opening Outlook for the First Time

When you open the program, you are asked if you want Outlook to 
be your default email program. Answer “yes.” 

Outlook will guide you through 
the process of adding your 
email accounts. 
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Adding Additional Email Accounts

You may have one email address for work and another for 
personal use. You may have several additional email accounts. 
Outlook will check all of your email accounts. You simply have to 
add each account together with the necessary information, such 
as the email password.

From any module in Outlook, 
select “File.” You will see a 
button where you can add 
an additional account.



Setting Outlook to Open to the Calendar

By default, Outlook opens to email, 
but you can change that.  My preference 
is to have Outlook open to the Calendar.

1. From the File menu, click Options.
2. Click Advanced.
3. Where you see Startup in this folder, 

click Browse and navigate to Calendar.
After clicking Calendar, click OK each
time it is presented.

4. You may also want to check the box 
to have Outlook empty your deleted 
mail when you exit.
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Turning Off task Reminders

While you are accessing the Tools menu, 
let’s do one more thing. We will turn off 
the automatic reminder feature on tasks.

1. From the File menu, click Options.
2. In the left-hand panel, click Tasks.
3. Click Task Options.
4. Uncheck set reminders on tasks with

due dates, and click OK.

Why uncheck this box? If checked, a 
box would appear and an audible chime 
would sound for every task due that day. 
You always have the opportunity to set 
a reminder on an individual task if needed. 
That’s all you need.
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Showing the To-Do Bar (or TaskPad)

By default, when we click the 
Calendar button, we see only 
the Calendar. You will want the 
To-Do Bar as well.

From the View menu, select 
To-Do Bar and place checkmarks 
beside Tasks.
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Customize View Settings

While you now see your Task 
List, it lacks the fields which 
will make navigation easy. 
We will add these fields, 
and add other enhancements 
which will make the list 
appear the way we want.

Right-click on the header just above the line where you would 
enter a new task. If you are clicking in the correct spot, you will see 
the menu displayed in this diagram. 

From the menu, select View Settings.
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Adding Fields

Let’s start by selecting Columns. After we establish those fields, 
we will return to this same screen to Sort, Filter and use 
Conditional Formatting.
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Choosing Your Columns

From the drop-down menu, select Frequently-used fields. Select 
the fields from the left and click Add to have them populate the 
box on the right. 

Click the columns in the 
order you see listed. 
If needed, you can 
rearrange the list by 
clicking Move Up or 
Move Down or by 
dragging the items up
or down.
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Sort the Task List by Due Date & Priority

Next, click on “Sort.” 
Sort by “Due Date.” Tasks that are
overdue will appear at the top.

Apply a secondary sort by “Priority.”
The way I use to Priority is to
indicate during what part of the
day I want to accomplish each task.

I like to think of “High,” “Medium,” 
and “Low” priority as representing
morning, afternoon, and evening,
respectively. 
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Filtering Tasks Which Start in the Future

If the start date of a task is in the future, you do not want it to 
appear on your Task List until that day. We will add a filter which 
removes from view any task whose start date has not yet arrived.

Return to the View Settings screen. This time, choose Filter. Click 
the Advanced tab. From the Field
drop-down, choose Frequently-
used fields. This time, choose 
Start Date. The condition will be 
on or before. For value, key the 
word today. Click Add to List and 
OK your selections.
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Other Filters

By default, you should have seen two rules already: 1) Date 
completed does not exist and 2) Flag completed date does not 
exist. Those rules are fine to leave as is. If you do not have the first 
rule, you will want to add it. That one causes tasks you have 
completed to disappear from 
the list. Otherwise. You would 
soon have a screen full of tasks 
with checkmarks beside them. 
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Adding Color to the Task List

By default, when a task is 
overdue, it turns red. 
Everything else is black. 

On my list, overdue tasks 
are red, tasks due today are 
blue, tasks due tomorrow
are green, and everything 
else is black.

We will return to the 
View Settings screen. 
This time, choose 
Conditional Formatting.
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Conditional Formatting

We will add two rules, one called Due Today 
and one called Due Tomorrow.

Click Add, key the name of the rule (Due Today), 
and click Font. Choose a color and OK your selection.

Click Condition and then the Advanced tab. 
Choose Due Date from the Frequently-used 
fields drop-down. For the condition, choose 
today. Click Add to list and then OK.

Repeat the process to add your second rule, the one
you will call Due Tomorrow. I chose blue for Due 
Today and green for Due Tomorrow. You may select
any colors you like.

When you return to the task list, you will see the
results of your work. 
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Task Module

You have completed setting up the “To-Do Bar.” Now, you will 
perform the same setup with the Task module.

At the bottom left of the 
screen, click the icon 
representing Tasks. 
Set up “Columns” and 
“Sort” exactly as you did 
with the To-Do Bar.
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Task Module

Click the “Filter” button.
Choose the selections you see 
to the right.

You will see a difference from
what you filtered in the To-Do
Bar. Here, we’re not going to 
filter out tasks with a future
start date.

The result is a list of all tasks.
This arrangement allows you to search for and edit tasks planned 
for far into the future.
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Planning My Day and Week

To plan my day, I scan the list for the Fab 5, the five most important items for me to 
complete during the day. I want those items at the very top of the list, so I assign 
them due dates far enough in the past that they will sort to the very top of the list.  

Next, I want to batch related items. Tasks I wish to tackle in the morning will be 
assigned a priority of High. Middle is for afternoon and Low for the evening.

Do you see tasks that are overdue and will not likely be completed today? Choose a 
different due date so they disappear. You can always see them by clicking the Task
button.

Look for ways to batch related items:

1. Saturday is a good day for me to run errands, so errands get a Saturday due date. 
When Saturday arrives, all of the errands are batched together. 

2. I routinely assign a due date of Friday to items I have delegated to someone else. 
On Friday, I see all of the items on which I need to follow up with someone else. 
I also assign a Friday date to tasks I simply want to accomplish sometime by the 
end of the week. 
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Planning My Day and Week

3. We all need that Master List of tasks of low-priority items. I assign a due date of 
the last day of the month. When I have extra time, I can scroll to the last day of 
the month in the Task module and select some of those items. This strategy 
also guarantees that when the last day of the month arrives, I will see those 
items and can assign a date to them for the following month.



Adjusting Column Width

You can adjust the width of any column by clicking on the divider 
between columns and dragging right or left.  Here is my strategy:
1. The left-most column is the Checkbox, so that I can mark the 

task complete.
2. The Priority column allows me to choose an exclamation point. 

I typically use it when a task has a start date in the future, yet 
when the start date arrives, the task must be done that day. 
The exclamation point calls my attention to that task.

3. I make the column for the Task Subject wide to provide plenty 
of room to clearly and completely word the task.

4. The next column is the Start Date. I rarely need to see what 
that date is. But, if I want to reschedule the start date, I can do 
so front right on the screen.

5. The Due Date is wide enough I can see the month and day. 
Being able to see this date clearly lets me know if I am 
bumping up against a deadline. 
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Adjusting Column Width

6. The Notes field is wide enough for me to see if there is 
anything in it. I often use the note area of a task to house any 
follow-up action. For example, if I am going to call Buford, and 
then I will call Penelope to tell her what Buford said, my task 
would read, “Call Buford.” In the note area of that task, I would 
write, “Call Penelope about Buford’s response.” When I place 
the call to Buford, before I check if off as done, I want to see if 
there is follow-up information in the note area. Having that 
field display on the Task List allows me to see if there may be 
follow-up information.

7. The final column allows me to see if the tasks repeat. I never 
change dates on repeating tasks. 
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Changing Due Dates

There are several ways you can enter the date:

1. Click on the date and a calendar appears. Choose a different 
date.

2. After changing one date up using the pop-up calendar, you can 
use the up or down arrows to move about the list and simply 
enter new date.  
• 5/20/2018 is interpreted as May 20, 2018.
• 5/20 is interpreted as the May 20th of the current year 

provided the entire month of May has not passed. If May 
has passed, the date assigned will have next year’s calendar 
year. 20 is interpreted as the 20th day of the current month. 
This shortcut is one I use daily. As I arrow up and down the 
Due Date column to organize my list by changing due dates, 
I am simply entering numbers between 1 and 31.
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Adding Additional Information About a Task

One area where a digital Task List outshines a paper one is the 
ability to house additional information. If I double-click a task, I 
have a large area where I put information related to that task and 
where I put follow-up tasks to be handled afterthe one at hand has 
been completed. 
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Hyperlinks in the Note Section of a Task

If I key or paste a URL into the note area, the result is a clickable 
link. 
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Keyboard Shortcuts

Outlook has several handy keyboard shortcuts. The great thing about 
them is you can use them from any Outlook module. For example, you 
can be in e-mail when you think of an appointment you need to add. You 
do not have to click the Calendar button. You may use the shortcut  of 
Ctrl+Shift+A to create an appointment while you are still in e-mail.

Keyboard Shortcut Action Performed by Shortcut
Ctrl+Shift+A Creates a new Appointment from anywhere in Outlook
Ctrl+Shift+C Creates a new Contact from anywhere in Outlook
Ctrl+Shift+K Creates a new Task from anywhere in Outlook
Ctrl+Shift+M Creates a new email Message from anywhere in Outlook
Ctrl+Shift+N Creates a new Note from anywhere in Outlook
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Goals or Projects

Goals or projects are different in that they are completed only 
after a series of tasks are handled. In my system, I handle an entire 
goal or project with a single Outlook task.

I start by defining the goal. I phrase it as a statement with a noun
up front and the statement is either true of false:

• Grant proposal has been submitted
• Secretary has been hired
• Car has been purchased

Each of these goals will be 
checked off as done only after
a number of steps have been 

completed.
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Next Steps, Goals, and Other Info

After defining the goal, I enter it into the subject line of the task. I 
precede the goal with “xx” and a space. My charge now is to 
brainstorm the steps needed to complete this goal. Sometimes I can 
list every step. Other times, I can list only one. The other steps often 
become evident as the goal evolves. Results of one step often shape 
what other next steps will be. 

In order for the goal to move forward, I must define at least one next 
step. I place it on the subject line before the “xx.”

What if I know other next steps? I list
those in the note area. I also use the 
note area for other information I 
happen to know about the task. 

When I complete the next step, I do
not check off the task as done. 
Instead, I highlight and delete that
next step and replace it with another
next step. 
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Examples of Goals, Next Steps, and Info

Here are the examples of goals you saw earlier accompanied by next steps:

•Call Jim re: budget figures xx Grant proposal has been submitted
•Search Internet for sample interview questions xx Secretary has been hired
•Consult Kelley Blue Book for value of present car xx Car has been 

purchased

The idea is that each next step must be clear and easy to accomplish.

In this example, the goal is to develop a system for delivering professional 
development online. The next step for moving this goal forward is to count 
how many licenses will be needed, a figure
which will impact the overall cost. The note
area houses important information, such
as when the grant is due and other next
steps to handle during the life of the goal.
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Setting Up the Task list

To this point, we have used to the To-Do Bar for our tasks so that 
we can see that calendar and tasks side by side. The only problem 
is that the to-do bar lacks a search feature. In a moment, you will 
see how you can click the Tasks button to conduct a search. First, 
let’s set up the Tasks module so that it looks like our To-Do Bar.

Click the Tasks button at the bottom of the screen. Click View and 
choose View Settings. You will go through exactly the sae routine 
that you did to organize the To-Do Bar.

1. Click Columns and select the same columns you chose earlier.
2. Choose Filter. Here, you are going to want to see every single 

tasks you have planned. The only tasks you want to exclude are 
those you have already completed. Click the Advanced tab. 
Click the Field drop-down and select Frequently-used fields. 
Select Complete, equals, and no.  Click Add to list and OK.

3. If you wish to set up Conditional Formatting so that tasks due 
today are blue and task due tomorrow are green, you may do 
so. Follow the same procedure you did with the To-Do Bar.
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Searching

What if I am looking for a certain task? Jim walks in the door 
unexpectedly. I know I have items on my Task List related to Jim, 
perhaps with varying due dates. Wouldn't it be great if I could 
quickly put my hands on all of the tasks related to “Jim”? 

To search the Task List, I click the Tasks button at the bottom 
of the screen and choose Tasks. I enter my search term in the 
search window. 
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Searching

The ability to search gives a digital Task List a huge advantage over a 
paper one. You just saw one example of such a search—finding all 
mentions of the name of a person. Here are three more common 
examples.

Call—If I am consistent about putting the word “call” in any task that 
involves a phone call, entering “call” in the search window, returns a list 
of every phone call I need to make in order by due date.

ETR—Many years before going to a digital system, I established the 
habit of tracking what I was expecting to receive from others. Whether 
it was a book borrowed, merchandise ordered, or a phone message 
left, the abbreviation “ETR” served then and now as a reminder of what 
I am expecting to receive. In my digital system, entering “ETR” in the 
search window returns a list of every task where the ball is in someone 
else’s court.

xx—Because I use “xx” to separate the next step from the goal to which 
it relates, entering “xx” in the search window return a list of every goal 
or project together with its next step and is sorted by due date.
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Email—”In” to “Empty”

Because Outlook is an integrated program, each of the modules 
“talks” to one another. There is no better example than email.

We empty our metal mailboxes daily and make 
decisions about each item. We would never 
consider reading our mail and putting it back 
in the mailbox. Each day’s delivery would be 
piled on that of the day before.

Yet, that is exactly how most of the world today
handles the email Inbox. The emails contain 
important information about where we need 
to be, what we need to do,  some valuable 
reference information, and email which simply 
needs to be saved for documentation purposes. 

It all stays in the Inbox because people lack 
strategies for doing any differently. We can 
change that!
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Drag and Drop Appointments

Imagine an email which announces a retreat. The email contains 
information on date and times, location, driving directions, and 
agenda. It even includes a piece of homework—to visit and study 
data from a particular website. 

Because the information is 
important and will be needed 
later, it sits in the Inbox. 

But, there is a better way!
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Drag and Drop Appointments

Click on the email and drag it to the Calendar button. When you 
release the mouse button, you will find Outlook has created a new 
appointment. The subject of the email becomes the subject of the 
appointment, but you can change it. The entire body of the email 
is contained in the note area of the appointment. Add a date and 
time and save the appointment. Now, all of this information is on 
your Calendar.
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Drag and Drop Tasks

The same email contains instructions to visit a particular website 
before the retreat. That’s a task. Click on the email and drag it to 
the Task button. Outlook creates what you see here—a new task. 
The subject of the email becomes the subject of the task, but you 
can edit it. The entire body of the email appears in the note area 
of the task. 

Edit as needed. Set a 
start date, due date 
and save. This item is 
now on your Task List.

With the calendar 
information on your 
Calendar and the 
to-dos on your Task 
List, you may now
delete the email!
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Drag and Drop “ETR” Items

When we place an order, we generally receive a confirmation 
email. It’s great information to have three weeks from now when 
the merchandise we expect to receive has not arrived and we 
want to check on it. It’s terrible 
information to sit in the Inbox for 
the next three weeks.

Drag the email to the Task button. 
Decide when you want to see the 
information. Set a start date,  due 
date, and save.

Now delete the email!
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Reference Information

What if the email contains good reference information? Drag it to 
Notes in Outlook. Or, you can go to “File” and “Save as” and save it 
where you would save similar items on your computer’s hard 
drive. 
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Documentation

What about the remaining emails? There are going to be emails 
which require no further action, but you need to save them for 
documentation purposes. Archive those emails. On the Home tab, 
you see this row of button:

Click on an email in the list 
and click the “Archive” button. The message is no longer in your 
inbox. If you would like to select more than one email at a time, 
hold the <Ctrl> key (on Windows) and click the emails one-at-a 
time. If you click an email, hold <Shift> and click another email, 
Outlook highlight all emails in between. 

To search for an email you archives, look for “Archive”
in the menu on the left of the screen. Use the 
“Search” menu at the top to refine your search. 
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“In” Becomes “Empty”

You have worked through your email…

• Calendar information is now on your Calendar. 
• Tasks to perform are now in your Task List. 
• Tasks others should be handled have been forwarded to them, 

and you have an ETR in your Task List so you may follow up as 
needed.

• Reference information is in 
Notes, OneNote, or saved in
your folder system within 

your computer.
• Information needed to save 

for documentation is in 
“Archive.”

Now, your Inbox is empty!
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This short e-book has as its focus a single aspect of Outlook—the 
Task List. It is my hope that you have a better understand of how 
to use this powerful feature of Outlook.

Today’s world offers many alternatives. If you are using another 
software program to manage your tasks, the methodology offered 
here will likely work with your software. Being able to search, 
being able to assign due dates and sort the list by due date, being 
able to establish repeating tasks, and having a note area attached 
to each task—all of these are common features of task 
management software. Feel free to take the concepts you have 
learned here and apply them to the software of your choice.
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Comments from past workshops attendees 

❖ “This morning when I returned to the office I did my first ever drag and 
drop to my calendar on Outlook - wahoo! The tickler file will come next 
week!”

❖ “One of the most informative sessions I have been to in 5 years.”

❖ “I saw your presentation at the ASCD conference in New Orleans and 
was blown away.  Please send me your monthly email essays.”

❖ “Practical down to earth user-friendly content. Excellent!”

❖ “One of my professional goals is to be more organized and to manage 
time more effectively. This hit the target.”

❖ “Thank you. These are tools I can and will use! WHEW!”

❖ “Practical, down-to-earth user-friendly content. Excellent!”

❖ “Where have you been all my life?  This is a great idea! Thank you so 
very much.”

❖ “FANTASTIC! One of the best I’ve been to! I could have stayed longer.”

❖ “Awesome ideas to get my life on track. Thank you so much!”

❖ “You changed my life!”
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Comments from past workshops attendees 

❖ “Great workshop. Fabulously well informed and entertaining presenter 
who shared his knowledge in a readily understandable format. Helpful 
handout. Thank you � well worth the trip from Ottawa.”

❖ “I really loved the presentation!! Dr. Buck very thorough and 
entertaining. Great, practical ideas and the Faculty Club was a great 
setting! Well done!!”

❖ “I loved this seminar!! Very, very well presented. Clear, logical, Dr. Buck 
was enthusiastic and witty. Very practical information that I will put to 
use immediately.”

❖ “Great presenter. Was very informative, practical info to apply right 
away.“

❖ “As a new administrator, I found this workshop to be extremely helpful. I 
got affirmation on some of the things I was already doing and many 
great new ideas! Thank you. Would definitely recommend to others. 
Frank Buck provided many ideas that will make my job as an 
administrator 10 times easier.“

❖ “This might very well be some of the most useful, timely and necessary 
professional learning I've done in years. Thank you!”

❖ “Excellent presentation. Dr. Frank Buck is friendly, interesting, and 
knowledgeable. Well done! This seminar was amazing”



Additional resources:
Get Organized! Time Management for 
School Leaders (2nd Edition)

You can order from Amazon.com
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https://www.amazon.com/Get-Organized-Management-Leaders-Education-ebook/dp/B01416XQSG/ref=sr_1_1?ie=UTF8&qid=1550107925&sr=8-1&keywords=frank+buck+get+organized
https://www.amazon.com/Get-Organized-Management-Leaders-Education-ebook/dp/B01416XQSG/ref=sr_1_1?ie=UTF8&qid=1550107925&sr=8-1&keywords=frank+buck+get+organized
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Frank Buck

Consulting, Inc.

531 Eagle Pointe Lane

Pell City, AL  35128

(205) 338-0384

Now that you have finished this e-book, 
let’s stay in touch.

Join my email list for regular tips on 
organization and time management.

Best wishes in your efforts to 
“Get Organized!”

—Frank Buck
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“Organization Made Easy”

https://visitor.r20.constantcontact.com/manage/optin?v=001XIhO0M9ckR78PL-yTd-8kAHNx4DogF92YwFHbvIj7xTBE_VrX_wHNcUbqmU7X15aEV-pdtlMmu30qFkfsj4ahA%3D%3D

